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Dolby CP650 Cinema Processor

Chapter 1
Introduction
1.1

Scope of this Manual
This manual describes the use of the CP650 Setup Program, a Windows application
for configuring the CP650 and the Reader Alignment Program.

1.2

Related Documents
Model CP650 Digital Cinema Sound Processor, Dolby Part No. 91569.

1.3

Software Description
This software is designed to set up and configure the Dolby CP650 from a Windows
95, Windows 98, or Windows NT computer. The software can be run either as a
stand-alone application or connected to a CP650. In either case, parameter files can
be saved on the PC hard disk for later retrieval and editing.
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1.4

System Requirements
The CP650 Setup software and the Reader Alignment program will run on Windows
95, Windows 98, or Windows NT 4.0 or later. The computer used should be a 486type or better and have ten megabytes of available disk space. Only a single instance
of each application can run at one time.

1.5

Hardware Connection
1. Connect an RS-232 serial cable (pin-to-pin) to any available serial port on your
Windows machine.
2. Connect the other end to the "SERIAL DATA" port on the CP650 (either front or
rear port will do).

1.6

Software Installation
The CP650 Setup software may be provided on diskettes or CD ROM.
Note: If you have an earlier version of CP650 Setup installed, remove it before
installing new software.
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Diskette Installation
1. Place diskette 1 in the PC and run Setup.exe.
2. Select the desired language.
3. Following screen prompts until installation is complete.
CD ROM
1. Open the CP650 Setup folder and run Setup.exe.
2. Select the desired language.
3. Following screen prompts until installation is complete.

1.7

Launching the Setup Application
1. Launch the Dolby CP650 Software. Click the Start button and scroll to
Programs. In the Dolby folder, select CP650 PC Setup Software.
2. From the Action menu, select Communications Setup. Select the Com port to be
used to communicate with the CP650.
3. From the Action menu, select Connect to connect to the CP650.
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4. You may be prompted to Send or Retrieve the settings. Once connected, the
CP650 front panel should indicate External Control Active.
5. Adjust settings using the Setup window.
When Connect is selected from the menu or tool bar, Setup attempts to connect the
selected communications port of the PC to the serial interface of the CP650. Upon
connection, CP650 Setup will automatically retrieve the parameter file from the
processor or will prompt to Retrieve or Send settings. If Retrieve is selected, Setup
prompts to save the current settings (existing parameter file in the PC prior to
retrieving settings from the CP650). If Send is selected, the parameter file that is open
in the PC will be sent to the CP650.

Figure 1-1 Retrieve/Send Dialog Box
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Once connected, the user can adjust settings through the Setup tab property pages.
Any changes to the settings, such as moving a slider control, are reflected
immediately in the current operation of the CP650. Changes are saved to the
permanent CP650 flash memory upon disconnect or exit from the Setup software. If
the CP650 is turned off before disconnect from the Setup software, any parameter
changes will be lost.
When connected, the fader knob is locked out.
Any adjustment marks the open parameter file as modified, and any attempt to exit or
open a different file prompts the user to save the current file.
Note: This is different from the front panel of the CP650 operation. On the front
panel, you must explicitly Save each change via the OK button before leaving the
screen for that setting.

1.8

Launching the Reader Alignment Application
To launch the Reader Alignment application, click the Start button and scroll to
Programs. In the Dolby folder, select CP650 Reader Alignment.
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Chapter 2
Setup Window
The main window of Setup contains the title bar, which displays the application name
and the name of the current parameter file, a menu bar, tool bar, status bar, and the tab
property pages.

Figure 2-1 CP650 Setup Window
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The program opens with a new, untitled Setup window. Once any setting is altered in
the current parameter file, that file is thereafter known as “modified.” Once modified,
any attempt to open a different file (new or existing) or exit the application will
prompt the user to save the current settings. The file can be saved to the same file
name that was opened or, in the case of the Untitled file, to a new file name on the
PC. The user can work with the software at length in this manner to create files with
different configurations, all without ever connecting to a cinema processor.
Note: A number of setup tabs cause the format of the CP650 to change automatically.
This change will not be reflected on the front panel of the CP650.
When leaving a tab that has forced a format change, the previous format is restored.

2.1

Menus

2.1.1

File Menu
New – Ctrl+N
When a New file is requested, the current document is closed (the user will be
prompted to save if the current document has been modified) and a new Untitled
document with default settings is opened.
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Open – Ctrl+O
Open an existing file from the PC file system, with a filter for *.dby files, CP650
configuration files. When a file is chosen, you will be prompted to save the current
file if it has been modified.
Save – Ctrl+S
Use Save to save the current settings. In the case of an untitled document, there is a
prompt for a file name.
Save As
Use Save As to save the current settings to a file other than the file open in the Setup
window. That file then becomes the current Setup file.
Revert to Saved
Use Revert to Saved to ignore any changes made to the open file and revert to the
previously saved version of the file. A confirmation prompt is displayed. After the
original file is loaded, the settings are automatically sent to the CP650 if connected.
Previous Files
When the File menu is opened, a list of the most recently used files from the PC file
system is displayed.
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Exit – Alt+F4
This command will disconnect from the CP650 if connected, close the current
document, prompt to save if modified, and exit the application. This operation is
canceled if the user chooses Cancel when prompted to save the current modified
document.

2.1.2

Action Menu
Connect/Disconnect
The Connect command is used to establish a serial connection to a CP650. After
connecting, this Action menu command changes to Disconnect. The Disconnect
action severs the serial connection and restores the CP650 to normal stand-alone
operation. There is no confirmation prompt when Disconnect is selected. After
disconnecting, the Action menu command changes back to Connect.
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Figure 2-2 Connecting to the CP650
If successfully connected, the prompt to either Send or Retrieve settings is displayed.
Pressing Esc at this time will cancel the connection.
Update Software – Ctrl+U
The CP650 software may be updated from a file on the PC. The CP650 will automatically
reboot once the software update is complete. Following the reboot, CP650 Setup will
refresh the CP650 settings to the same state they were in prior to the update.
One of the key functions of the Setup software is to update the embedded control and
DSP code in the flash memory of the cinema processor. The update comes as a single
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package that represents a complete system snapshot. This package is available from a
distribution disk or the Dolby extranet website. Upon selection of the Update Software
action, Setup will prompt to save the current settings before proceeding. This is not
absolutely necessary as the existing parameters will be packaged with the new software,
however, it is always a good idea to save settings. Setup will present an Open file dialog
to locate the file on disk. The software update file will have a file extension of .bin. Upon
reading this file, Setup will present the Update Software dialog that displays:

Figure 2-3 Update Software
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Mute – Ctrl+M
The Action menu Mute command is equivalent to pushing the Mute button on the
front panel or clicking the Mute button on the Setup toolbar. The command toggles
the mute state of the CP650.
Communications Setup
Use the Communications Setup command to select the serial connection to the
CP650. A list of the communication ports is displayed.

2.1.3

Signal Menu
The Signal menu allows the selection of the signal to be used for several alignment
operations. Certain setup tabs will force or provide their own signal selection options.
The current signal selection is displayed in the status bar area at the bottom of the
main window.
Program
Selecting Program effectively restores the cinema processor to the last film format
that was in effect.
The available test signals available on the CP650 are:
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•
•
•
•

2.1.4

Setup Window

100 Hz Sine Wave
1 kHz Sine Wave
10 kHz Sine Wave
Thump, at 1-second intervals - this low-frequency signal is used with the phase
checker.

Window Menu
Event Log – Ctrl+E
The Event Log command displays the Event Log window. The Event Log
immediately receives and displays the current event log information from the cinema
processor. This log includes a date/time stamp, summary, and description for each
event. The source and details of each event are determined by the cinema processor
control software.
The Event Log window provides options for printing the Event Log and saving the
Event Log as text.
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2.1.5

Setup Window

Help Menu
About this Cinema Processor…
This window displays the firmware version and Ethernet address.
About this Software…
This window displays the revision number of the Setup software, and copyright and
license information.

2.1.6

Tool Bar
The main frame tool bar includes buttons for quick access to commonly used menu
commands, a master fader, and mute control. The tool bar is oriented vertically on the
left edge of the frame and contains buttons for the following commands:
New
When a New file is requested, the current document is closed (a prompt to save the
current document if it has been modified will appear) and a new Untitled document
with default settings is opened.
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Open
Use the Open command to open an existing file from the PC file system. Cinema
Processor files have the extension .dby. If a file is chosen, the current file is closed
with a prompt to Save if modified.
Save
Save is enabled if the current document is modified. It saves the current settings
document with the same name. In the case of an untitled document, the user is
prompted for a file name. After performing a Save, the Save menu option is disabled
as the document is no longer modified.
Connect/Disconnect
Use the Connect command to establish a serial connection to the cinema processor. If
successfully connected, follow the prompt to either Send or Retrieve settings as
necessary. After connecting, this command changes to Disconnect.
The Disconnect action severs the serial connection and restores the CP650 to normal
stand-alone operation. The Setup software does NOT prompt, save, exit, close, or
otherwise alter the current parameter file when disconnecting. The Disconnect
command then changes back to Connect. Upon disconnection, any changes made to
the CP650 settings are made part of the permanent flash memory in the unit.
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Master Fader
The function of the fader is to adjust the gain of the output according to the
Fader Law shown in Figure 2-4 Fader Law. As the Fader increases from 0
to 4 in increments of 0.1, the gain will increase from -90 dB to -10 dB. This
translates to an increase of 20 dB per whole fader unit. As the fader increases
from 4 to 10 in increments of 0.1, the gain will increase from -10 dB to 10
dB. This translates to an increase of 3 1/3 dB per fader unit. The fader level
is displayed on the CP650 front panel in a two-digit, seven-segment display.
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Figure 2-4 Fader Law
The master fader includes a fader level display, a slider to adjust the level, and a mute
button that correspond directly to the analogous display and controls on the front
panel of the cinema processor. The master fader is enabled whenever the Setup
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software is connected, except when a tab is displayed which prescribes that the master
fader be fixed at 7.0 (e.g., B-Chain EQ, Room Levels when Pink Noise is selected).
Mute
The Mute button controls the master mute function of the CP650. When the mute
function has been activated, the Mute key on the CP650 front panel will flash. When
the unit is unmuted, the illumination will extinguish. The speed at which the
mute/unmute functions occur are set with the Fade In Speed and Fade Out Speed
control described in Section 2.12.1.

2.1.7

Status Bar
This area at the bottom of the main window displays help text for menu options, the
current status of the signal source, and the cinema processor link status, Connected
along with the baud rate or Disconnected.

2.2

Profile Tab
This tab allows the user to enter identifying information about the cinema processor,
theatre, and settings file. The entries made on this tab are not stored in the cinema
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processor. When a new file is created (at startup or by using File->New), this
becomes the top tab, and the cursor is set to the first field for data entry.
The Profile tab should be used to record system configuration details. The information
entered, along with the setup parameters, can then be saved to a file and reloaded as
needed.

Figure 2-5 Setup Profile Tab
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2.2.1

Setup Window

Cinema Processor Serial Number
Enter the serial number of the cinema processor to maintain a full record of the
system setup.

2.2.2

Dolby Digital Reader 1/2 Unit Serial Number
Enter the digital reader serial numbers to maintain a full record of the system setup.

2.2.3

Cinema Processor Firmware Version Number
Information about the cinema processor is sent from the CP650 to the PC when a
connection is made. The Firmware Version Number, DSP Version Number,
Option Card, and Ethernet address will then be displayed.

2.2.4

Cinema Processor DSP Version Number
The CP650 module version string is sent from the CP650 to the PC when a
connection is made.
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Setup Window

Cinema Processor Option Card
Information about installed option cards is sent from the CP650 to the PC when a
connection is made.

2.2.6

CP650 Ethernet address
If an Ethernet card is installed in the CP650, the address will be read by the PC and
displayed on this tab.

2.2.7

Additional Fields
Enter data for the remaining fields as desired: Project Name, Theatre Name, Screen
Number, Projector Model Number, Automation System, and Comments.

2.3

Optical Tab
This tab is used to configure the optical settings in the cinema processor, including level
and slit-loss equalization. When the Optical tab is selected, the format automatically
changes to Mono (Format 01). Optical adjustments require the use of Cat. No. 69T and
Cat. No. 69P test film.
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Figure 2-6 Setup Optical Tab

2.3.1

Projector 1/2
Click on Projector 1 or Projector 2 to begin adjustment of projector one or two.

2.3.2

Lt Level and Rt Level Adjustments
While running Cat. No. 69T, Dolby Tone Test Film, Lt and Rt may be adjusted
individually using the associated slider until both green elements are illuminated.
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(Click Lt or Rt Level slider to activate the spectrum analyzer display.) This assures
the correct input level to the CP650. Alternately, click Auto Level to allow the CP650
to perform the adjustment.

2.3.3

Auto Level
Click Auto Level to allow the CP650 to automatically adjust the Lt and Rt preamp
gain levels.

Figure 2-7 Auto Level in ProgressAdjustment Complete

2.3.4

Level Out of Range

Slit-Loss EQ
The Slit-Loss EQ is an equalization curve that compensates for optical deficiencies
that result from slit height variations. The curve provides a unique high-frequency
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boost that compensates for these variations. The level of correction necessary will
vary by reader type. Typically, reverse-scan basement readers require less adjustment
than forward-scan readers.

2.3.5

Left/Right
Adjust the Left and Right Slit-Loss EQ for the most extended high-frequency
response without forming a peak.

2.3.6

Auto EQ
Alternately, click Auto EQ to allow the CP650 to perform the adjustment. A dramatic
difference in the Left and Right levels may indicate an optical problem.

2.4

Room Levels Tab
The current signal selection (Pink Noise, program, 100 Hz, etc.) is maintained
between pages that support the Pink Noise option (B-Chain EQ, Room Levels, and
Subwoofer EQ) Switching the signal mode to Pink Noise clears all the channels.
With Pink Noise on, all channels are mutually exclusive—selecting any one clears
any other selection. To select multiple surround channels, hold the Control key down
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while making selections. Screen channels cannot be used in combinations in Pink
Noise mode. The subwoofer channel is independent in all cases.

Figure 2-8 Setup Room Levels Tab

2.4.1

Surrounds
Surrounds define the configuration of the surround channels for output-level adjust
and B-Chain EQ. If operating disconnected, the interface provides two options for
surround configuration. If connected and a Surround EX adapter card is installed in
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the CP650, the selection is forced to Surround EX and the button is disabled. If no
Surround EX card is installed, the Surround EX button choice is not available.
Conventional 5.1
This is the default setting. Dolby Digital utilizes discrete left and right surround
channels. During optical film playback, both Ls and Rs are fed an identical mono
surround signal.
Surround EX
Surround EX includes channels Ls, Bsl (Back Surround Left), Bsr (Back Surround
Right), and Rs.

2.4.2

SPL Meter
The Internal SPL meter can be used to set room levels of each channel if calibrated.
The microphone is connected through either the rear XLR connector or the front Mic
Mux connector.

Figure 2-9 Internal SPL Meter
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Internal Calibration
Click Calibrate Internal Meter to enable microphone calibration. Pink Noise will be
routed through the center channel. While using an external SPL meter in close proximity
to the microphone, dial in the SPL reading to match what is detected in the theatre. Click
Calibrate to calibrate the CP650 and microphone to the SPL reading. If an error message
occurs indicating the microphone level is too low, check your connections, phantom
power and mic level trimpot located on the front panel of the CP650.

Figure 2-10 Error Message for Failed Calibration

2.4.4

Output Level Adjust
This group provides checkbox, label, static value display, and slider controls for each
channel as determined by the current Surround configuration. The value always
displays the current channel slider setting which, when connected, always matches the
setting currently in use in the cinema processor. When leaving the Room Levels page,
all channels are activated.
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Subwoofer Level
Clicking this button brings up the Subwoofer Level dialog box. This window
provides for level trim of the two subwoofer modes, optical and digital. Checkboxes
are provided to turn Center Noise and Reverse Sub Polarity on and off when the
Optical Level is selected; these checkboxes are disabled when Digital Level is
selected.
Note: The reference values will not be displayed on the Subwoofer spectrum analyzer
until the microphone is calibrated.

Figure 2-11 Subwoofer Level
The initial level setting for the digital subwoofer is 1. The optical subwoofer level is
relative to the digital level. If making adjustments to one, check the other.
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Center Noise and Reverse Sub Polarity are only available when adjusting the
Optical Subwoofer Level.
The Center Noise checkbox corresponds to the Center channel checkbox on the
Room Levels tab. It is initially selected if the Center channel checkbox was selected
on the Room Levels tab. If using the Setup analyzer, Center Noise should come up to
the 0 dB line. Digital subwoofer level should be trimmed to +10 dB while the optical
subwoofer level should be trimmed to 0 dB.
The Reverse Sub Polarity checkbox is initially clear. It is used to check for
subwoofer center channel phase matching. With Optical Level and Center Noise
selected, there should be some adding of the lower frequencies; with Reverse Sub
Polarity selected, there should be some noticeable subtraction of lower frequencies. If
the Reverse Sub Polarity checkbox is set when leaving the Subwoofer Level
window, a warning message to verify speaker connections is displayed and the
polarity returned to normal.

2.4.5

Signal
Signal Generator
The Signal Generator selection is maintained between pages that support the Pink
Noise option (B-Chain EQ, Room Levels, and Subwoofer EQ).
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Pink Noise
Dolby Level pink noise is used when this is selected. Initial selection of this option
clears all output channels. The user must then manually select to which channels to
apply the noise. If Pink Noise is selected when switching to a different setup tab, the
noise is turned off, and the signal output is returned to the global signal generator
setting.

2.4.6

Bypass
Pressing the Bypass Level button invokes the Bypass Level Adjust window. This
places the CP650 in Format 05. Clicking the Bypass On checkbox switches the
CP650 into Bypass mode. Adjust the Bypass Level trimpot to match the SPL of the
same film in Format 05.

Figure 2-12 Bypass Level Adjust
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B-Chain EQ Tab
The B-Chain EQ tab is used to adjust each channel’s frequency response to achieve
the desired response curve. This is achieved by using a combination of bulk and onethird octave EQ.

Figure 2-13 Setup B-Chain EQ Tab
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2.5.1

Setup Window

Channels
The current channel name appears at the top of the B-Chain EQ tab, as selected at the
bottom of the tab. The solid line on the graph represents the standard ISO 2969 curve.
When one of the frequency sliders is selected, the corresponding line segment is
yellow. The slider can then be adjusted for boost or cut.
With the cursor anywhere on the B-Chain EQ tab, click the right mouse button to
display Copy and Paste functions. These may be used to copy frequency settings from
one channel to another.

2.5.2

EQ Assist
Use this button to apply an approximation algorithm to bring the EQ for the channel
close to the desired response curve. Bulk EQ as well as amplifier gains should always
be adjusted before applying EQ Assist. EQ Assist is only enabled if the internal SPL
meter has been calibrated on the Room Levels screen and Pink Noise is activated.

2.5.3

Flatten EQ
Click Flatten EQ to return all frequency bands to zero. A prompt will appear for
confirmation.
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Bulk EQ
Bulk EQ is used to adjust the bulk equalizers. It is important to adjust both the Bass
and the Treble EQ prior to adjusting the individual one-third-octave bands.
Bass Level
The Bass Level is adjustable from –6 to +6 dB in 0.2 dB steps. Use the slider to make
adjustments to match the reference curve.
Treble Level
The Treble Level is adjustable from –10 to +10 dB in 0.2 dB steps.
Treble Freq
The treble corner frequency can be 1, 2, 3, or 4 kHz, and only applies to the Left,
Center, and Right channels. Adjust to match the reference curve as closely as
possible. (The corner frequency is fixed at 2 kHz for the surround channels.)

2.5.5

Channel Level
This slider may be used to adjust the output level of the currently selected channel and
is reflected on the Room Levels tab. This will not affect the overall level seen on the
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spectrum analyzer because the average of frequency bands 7 through 20 is always
placed at 0 dB.

2.5.6

Signal Generator/Pink Noise
Buttons are provided to select the signal source as Signal Generator or Pink Noise.
The spectrum analyzer is only active when Pink Noise is selected.

2.6

Subwoofer EQ Tab
This screen in used to adjust the subwoofer’s parametric equalizer. The three
parameters that define the equalizer are Frequency, Q, and Cut. Identify a frequency
region that may contain a peak and adjust the parametric equalizer to obtain a flatter
response. Note that the vertical axis will be unlabeled if the Internal SPL Meter was
not calibrated from the Room Levels tab.
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Figure 2-14 Setup Subwoofer EQ Tab

2.6.1

Frequency
The filter's center Frequency is adjustable from 25 to 125 Hz. The approximate
corresponding band will be highlighted on the real-time analyzer.

2.6.2

Q
The Q defines the width of the Cut band. The Q settings are 0.5, 1, 2, and 4.
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Cut
The Cut value is applied to the center Frequency as selected above, reducing the
output level in the Q region. The cut amount is adjustable between 0 and –12.0 dB in
0.2 dB steps.

2.6.4

Graph
When Pink Noise is activated, the graph will display the subwoofer frequency
response. With 0.0 dB of Cut, no cut, identify the frequency region with the tallest
bump. Adjust Frequency, Q, and Cut to achieve the flattest frequency response.

2.6.5

Signal Generator/Pink Noise
Buttons are provided to select the signal source as Signal Generator or Pink Noise.

2.7

Mono Tab
Selecting the Mono tab sets the CP650 to Format 01. The functions on this tab apply
to the Center channel while in Format 01.
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Figure 2-15 Setup Mono Tab

2.7.1

Mono Level Trim
Mono Level Trim adjustment can vary between -12 dB and 0 dB in 0.2 dB steps.
This trim is an offset from the normal playback level.
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Mono EQ
While monitoring film program material, adjust Mono EQ for preferred audio tonal
quality. There are 16 steps between the low-frequency and high-frequency settings for
the Mono EQ.

2.8

Misc Levels Tab
The Misc Levels tab provides sliders for adjusting the Optical Surround Level Trim
and Nonsync 1 and 2 levels.
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Figure 2-16 Setup Miscellaneous Levels Tab

2.8.1

Opt. Surr. Level Trim
The Optical Surround Level Trim is adjustable from -3 dB to +6 dB in 0.2 dB steps.
This applies to optical surround playback.
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Nonsync 1 and 2 Level
The Nonsync 1 and 2 adjustments are controlled by sliders. The number is unitless,
and ranges from 1 to 127.

2.9

Delays Tab
The Optical Surround Delay should be adjusted so that sounds from the rear of the
theatre (surround channels) arrive at the listener's ear approximately 20 ms after the
arrival of sound from the screen speakers.
The Digital Surround Delay should be adjusted so that sounds from the rear of the
theatre arrive at the listener’s ear at the same time as the screen speakers.
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Figure 2-17 Setup Delays Tab

2.9.1

Surround Delay
Optical
The Optical Surround Delay is adjustable from 20 to 150 ms in 1 ms steps. When
the Optical delay level is set manually, the Digital delay will automatically change to
the same level minus 20 ms.
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Digital
The Digital Surround Delay is adjustable from 20 to 150 milliseconds in 1 ms steps.

2.9.2

Delay Calculation
The Setup program can calculate and set both Optical and Digital Surround Delay
values based on theatre measurements entered here.
Feet/Meters
Measurements may be made in Feet or Meters. Select the desired units.
Distance from screen to rear wall of theatre
Values must be between 10 and 200, Feet or Meters.
Average distance between left and right surround channels
Values must be between 10 and 140, Feet or Meters.
Calculate
Click Calculate to calculate and automatically set the Surround Delay.
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2.10 Dolby Digital Tab
Selecting the Dolby Digital tab automatically sets the CP650 to Format 10, Dolby
Digital.

Figure 2-18 Setup Dolby Digital Tab
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Setup Window

Reader Delay
Reader Delay adjustment is used to synchronize the digital soundtrack with the
analog track and the picture. It can be set by selecting the reader model or by
manually adjusting the number of perforations when using the Cat 1010 Sync Test
Film.
Select Dolby Digital Reader Model
The specific reader model selection is shown in Table 2-1.
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Table 2-1 Dolby Digital Reader Models
Reader Model
Other (default)
Dolby Cat. No. 699/700/701
Ballantyne 35 penthouse
Century Projector with Component Engineering or Kelmar basement
Century 35mm (SA) penthouse
Century 35/70 (JJ) penthouse
Christie basement
Christie penthouse
Cinemeccanica V5 basement
Cinemeccanica V5 penthouse
Cinemaccanica V8 penthouse
Kinoton FP30
Norelco/Kinoton AAll (DP70) penthouse
Simplex with Component Engineering or Kelmar basement
Simplex 35mm (XL) penthouse
Simplex 35/70 penthouse
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Perforations
20
250
247
20
245
309
26
250
28
252
260
21
283
26
242
298
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Setup Window

Perforations
The number of Perforations to delay can be set from 16 to 512 using the up and
down arrows. When a reader is selected, as described above, the number of
perforations changes accordingly.

2.10.2

Auto Dolby Digital
If Dolby Digital is playing and another film format is selected the CP650 will go into
the selected format, and auto digital is temporarily disabled. Auto Digital will be reenabled when a non-film format is asserted and then a film format is asserted. At that
time the system is ready to automatically go into the target format when Dolby Digital
audio appears.
Auto Digital Target
The Auto Digital Target may be format 10, or format 13 if a Surround EX card is
installed.
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2.10.3

Setup Window

Reversion Mode

Figure 2-19 No Reversion Warning
With Reversion Mode set to Normal, the audio may revert to the analog soundtrack
if necessary. A setting of No Reversion will keep the CP650 in the target format
regardless of the condition of the Dolby Digital data.

2.11 Formats Tab
Use the Formats tab to enable and assign Preset Fader Settings, User formats, and
to select the Power-on Format.
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Setup Window

Figure 2-20 Setup Dolby Digital Tab

2.11.1

Enable Preset Fader Setting
Click on a box to enable the Preset Fader. Use the up and down arrows to modify the
Fader Setting between 0 and 10.0. The default Fader Setting is 7.0.
User 1, User 2, and Nonsync
User 1, User 2, and Nonsync may be set to any of the formats listed in Table 2-2.
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Table 2-2 Fader Setting Formats
Number
01
04
05
10
11
13
20
22
42
60
61

2.11.2

Format
Mono
Dolby A-type
Dolby SR
Dolby Digital
External 6-Channel
Dolby Digital Surround EX
35 mm Magnetic, 3-Channel
35 mm Magnetic, 4-Channel
70 mm Dolby Stereo
Nonsync 1
Nonsync 2

Number
64
65
66
70
71
73
74
75
80
81
87

Format
Public Address Center Channel
Public Address Surround Channels
Test Tone 320 Hz
Video PA (NS1)
Video Mono (NS1)
Video LCR (NS1)
Video Pro Logic no Subwoofer (NS1)
Video Pro Logic with Subwoofer (NS1)
Digital Input
External Dolby Digital with Surround EX
External 6-Channel with Surround EX

Power-On Format
Select the audio format for the CP650 when power is turned on.
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Table 2-3 Power On Formats
Power On Formats
Last Format
Format 01
Format 04
Format 05
Format 10
Format 11
User 1
User 2
Nonsync
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2.12 Misc. Tab

Figure 2-21 Setup Miscellaneous Tab

2.12.1

Mute
The length of time for sound to fade from normal to mute, when Mute is selected, is
the Fade Out Speed. The time to return from muted to normal is the Fade In Speed.
Both are adjustable from 0.2 to 5.0 seconds in 0.1-second intervals using the
appropriate slider.
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2.12.2

Setup Window

Clock
The current PC time and date are displayed. Use the Set CP650 Clock button to
synchronize the CP650 clock to the PC time.

2.12.3

Noise Gating
Pressing this button will put the CP650 in noise gate mode. Click OK to exit the noise
gate mode. When in noise gating mode, an automation line will control an internal
pink noise source. Pink noise is activated by shorting the automation line associated
pin to ground (pin 12); pin numbers 1 through 8 represent L, C, R, Ls, Rs, SW, all and
Bs.

2.13 Spectrum Analyzer Tab
The Spectrum Analyzer tab displays the frequency response of the selected audio
input. When the tab is selected, the default format is Nonsync 1. Only one channel
may be selected at a time.
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Figure 2-22 Setup Spectrum Analyzer
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Chapter 3
Dolby Reader Alignment Program
When Dolby Digital film is played through the CP650, additional information on the
Dolby Digital soundtrack is available from the cinema processor including block
positions, error rates, and other relevant parameters. Through the use of the Reader
Alignment software, Dolby Digital soundtrack information can be viewed in realtime from the CP650 without impacting the unit’s operation.
Note: This Dolby Reader Alignment software is for use on the CP650 only.
Although the Dolby Reader Alignment window is a valuable tool when aligning a
reader, an oscilloscope is still necessary to adjust the video amplitude.
The Reader Alignment window is an overlapping window that can show the current
information coming from the CP650 or the contents of a previously saved file. The
data may be saved as a log (*.qc) file to be replayed later or sent to someone else
(e.g., Dolby Technical Support) for replay at a remote site. This allows detailed
information about the functioning of a digital reader to be viewed by someone
remotely.
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Figure 3-1 Dolby Reader Alignment Window
The Reader Alignment window contains the title bar, which displays Dolby Reader
Alignment and the name of the current document, a menu bar, tool bar, status bar, and
the Reader Alignment Screen. The Reader Alignment window operates in one of three
modes:
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• Display Only
• Display and Log
• Open Existing File
Selection of the mode is done through the File menu.

3.1

Menus

3.1.1

File Menu
There is no explicit Save operation in the Dolby Reader Alignment. Files cannot be
appended or edited.
New Display
This command is available only when the PC is connected to a CP650. It will close
the current document and create a new Display Only document, which will NOT save
the data stream to a file.
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New Display & Log
This command is available only when the PC is connected to a CP650. This is the
only mode in which a new file is created. A prompt for the name of a new file is
displayed, and a new log document for that file is created. Starting the data stream in
this mode will save the new data to the given file for replay later or transmission to a
remote site.
Open Existing QC File
Use this command to open a previously saved QC file. If a file is chosen, the current
document is closed.
Close Reader Alignment
This command will close the Dolby Reader Alignment window.

3.1.2

Action Menu
Connect/Disconnect
Use the Connect command to establish a serial connection to the CP650. Prompt to
either SEND or RECEIVE settings for the main Setup frame as necessary. While
connected, this command changes to Disconnect. The Disconnect action severs the
serial connection with the CP650.
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Run/Stop
Click Run to begin the display of the reader alignment data stream either from the
CP650 or from the existing file already opened. After starting, the menu option
changes to Stop. Choosing Stop will terminate the processing of the data stream or
playback of the existing file.
Pause
When replaying a saved .qc file, Pause may be used to halt the replay. Use Run to
restart.
Communications Setup
Select the PC Com port to use for the serial connection to the CP650.

3.1.3

Speed
When an existing QC file is opened for playback, choose the speed at which playback
proceeds.
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Table 3-1 Playback Speeds
Playback Speeds
Pause
1x (default)
10x
20x
30x
40x
50x

3.1.4

Window
Event Log
See Chapter 4.

3.1.5

Help
See Section 2.1.5, Help Menu.
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Tool Bar
The Reader Alignment tool bar includes buttons for quick access to commonly used
menu commands. The tool bar is oriented horizontally just below the menu bar. The
tool bar contains buttons for the following commands:
Connect/Disconnect
This corresponds to the Action menu Connect/Disconnect commands. See Section
3.1.2.
Run
This corresponds to the Action menu Run command. See Section 3.1.2.
Pause
This corresponds to the Action menu Pause command. See Section 3.1.2.
Stop
This corresponds to the Action menu Stop command. See Section 3.1.2.
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Status Bar
This area at the bottom of the main frame window displays help text for browsing the
menu options, speed mode, and the cinema processor link status (Connected or
Disconnected).

3.4

Plot Window

3.4.1

Error History
The Error History graph shows the Error rating for each second of film. The error
rate numbers on the vertical axis of the graph are arranged with the highest quality at
the bottom and the lowest quality at the top. This makes low-quality ratings stand out.
One-second sections of film with correctable block errors are seen as cyan bars, and
unacceptable film sections stand out as tall red bars on the graph. This window can be
used to identify a region of the film where problems are occurring. It can also be used
to track improvements in reader alignment as they are being made.
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Figure 3-2 Error History

3.4.2

Histogram Plot
The Histogram Plot is dependent on print quality and reader alignment. Ideally, the
Dolby Digital film blocks would have perfectly clear (100% light transmission) pixels
and perfectly opaque (0% light transmission) pixels to represent the 1’s and 0’s. In
reality, a Gaussian-like distribution is seen for both the dark areas and the light areas.
On the horizontal axis the light range is displayed, with the dark area on the left and
the clear area on the right. On the vertical axis the relative quantities of pixels are
shown for a given light level.
Real film has a range of clear and dark levels as shown Figure 3-3. This histogram
shows two peaks that represent a wider range of light levels. It is very easy to
determine most of the clear pixels and most of the dark pixels. Special algorithms
have been developed to deal with the small number of pixels that fall in the gray area.
These algorithms determine a threshold value for the boundary between the clear and
dark pixels. If the histogram is degraded, with broad peaks, this can indicate
insufficient video amplitude. In addition, bad focus, incorrect magnification, and
badly aligned azimuth will cause broadening of the peaks.
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Figure 3-3 Typical Film Histogram
Figure 3-3 is a histogram of a typical film as it might appear in the Histogram
window. The histogram also includes two lines that show the relative position of two
of the factors used to determine the dark-to-clear boundary. The shorter of the two
lines shows the position of the determined threshold. The taller line shows the
halfway point between the peak values on the histogram. Ideally, the two lines should
be close together indicating sharp transitioning between pixels.

3.4.3

Contour Plot
The Contour Plot shows differences in film density between the lighter and darker
areas of the Dolby Digital data block region. The top line of the Contour Plot
represents the variations in light distribution across the data block. The bottom line of
the plot shows variations in film density of the data block.
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Figure 3-4 Contour Plot

3.5

Quality Window
There are ten parameters measured and displayed in the Quality window.

3.5.1

Corners Found
Registration patterns are placed in the four corners of every Dolby Digital block.
They are used by the Digital Processor to locate block position. The Corners Found
window indicates the percentage of registration patterns that have been located by the
Digital Processor. On good film prints this number is typically between 97 and 99.
Loss of corners found can be caused by incorrect lateral alignment, incorrect
magnification, bad focus, incorrect azimuth adjustment, or vertical jitter. In general,
corners must be found reliably before the system can function.
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Figure 3-5 Dolby Digital Block Corners

3.5.2

Reversion Count
The CP650 has been designed so that a burst of uncorrected errors may cause it to
switch from playing the digital soundtrack to playing the analog sound track on the
film. The Reversion Count window displays a running total of the instances where
the processor has reverted from digital to analog playback. A reversion will occur
when there are many block errors close together.

3.5.3

Error Rating
The CP650 employs an error correction circuit that can recover data lost due to a
variety of conditions. The Error Rating box indicates how hard the error correction
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circuit is working to produce perfectly correct data. Low numbers indicate low error
rate, higher numbers indicate higher error rate, mid range is typical. Block errors will
cause an F to be displayed. Poor reader alignment or damaged film will directly effect
error rate, and cause a higher number.

3.5.4

Lateral Position
The Cat. No. 530 test film should be used to adjust the lateral position of the reader to
the number indicated on the test film. The number reported in the Lateral Position
window is the offset distance from ideal position in mils (0.001 inch). A positive
number indicates an offset toward the closest edge of the film. A negative number
indicates an offset toward the picture area of the film.

3.5.5

Track Width (% Mag)
The number reported in the Track Width window shows the percentage of the
magnification. If the magnification is adjusted properly, the number should read 100%.
If the magnification is too low, it will read lower, and if the magnification is too high, it
will read higher. The track width should be set to 100%, with a range of 97% to 103%
being acceptable. On Cat. No. 699/700/701 readers, track width is set at the factory and
is not adjustable.
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Length (Feet)
Film length is shown in feet. This window is updated every foot.

3.5.7

Block Errors
The CP650 employs a multitude of ways to clean up data and correct errors from the
data stream. When the data on the film is not of good quality, the data may not be
correctable. The Block Errors window displays a running count of those instances.

3.5.8

Film Block Position Graphic
A graphic representation of the block position is displayed in the large box centered
between the quality windows. This display is updated in real time and can be used to
troubleshoot problems that show themselves as azimuth variations and flutter
frequencies.

3.5.9

Focus
The Focus window indicates the sharpness of the transitions from dark (digital 0s) to
clear (digital 1s) areas on the film. Higher numbers (66-100) represent good focus,
and lower numbers (0-33) indicate bad focus. The number that is displayed depends
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on the reader alignment and the quality of the film. This number is relative and should
be adjusted for the highest attainable value.

3.5.10

Azimuth
The number reported in the Azimuth window is the average azimuth over a onesecond interval. This number is reported in pixels. One pixel azimuth represents about
0.3 degrees of rotation. Using the Cat. No. 530 test film adjust the azimuth until the
number in the window matches the number indicated on the film.

3.5.11

Vertical Jitter
The number reported in the Vertical Jitter window is the peak variation of the Dolby
Digital block from its nominal position between two adjacent sprocket holes over an
interval of time. The number is reported in mils. Observing the number over time
gives the user an indication of any jitter in the reader. Typically the variation over a
few seconds is seen to be about 1.0 mils. Excessive jitter may indicate mechanical
problems in the projector or soundhead.
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Chapter 4
Event Log
Choosing the Event Log from the Window menu of either the setup program or the
reader alignment program, brings up the Event Log window. The Event Log
immediately receives and displays the current event log information from the CP650.
This log includes a date/time stamp, summary, and description for each event.
The Event Log window provides options for loading the Event Log from the CP650
and saving the Event Log as text. An example is shown on the following page.
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Cinema Processor Event Log
File
C:\650\South City 3 E. Log 4-5.txt
Date
05Apr2000
Time
11:14:20
System version
Setup version

1.0.3.3
1.0.8.4 Beta

Time
---23-MAR-00 14:53:35
27-MAR-00 09:19:07
27-MAR-00 12:10:33

Summary
------Startup
Startup
Startup

Figure 4-1 Event Log Example
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Description
-----------

